Chapter 5

Developing third-party FileMaker plug-ins

Making plug-ins accessible to users
  Installing plug-ins  36
  Enabling plug-ins  36
  Configuring plug-ins  37

Appendix A

Feature comparison of the runtime application with FileMaker Pro

Application and document preferences  40
Menu command comparison  41
Ignored script steps  46
Stored registry settings or preferences  47

Index  49
Welcome to FileMaker® Pro Advanced. This product includes advanced development and customization tools designed especially for database developers. You can use either FileMaker Pro or FileMaker Pro Advanced to create and test your database solutions.

In addition to all of the features that are available with FileMaker Pro, FileMaker Pro Advanced includes:

- Developer Utilities, for creating, customizing, and deploying runtime database solutions
- Database Design Report feature, for publishing comprehensive documentation on structures or schemas of databases
- Script Debugger, for systematic testing and debugging of FileMaker scripts
- Data Viewer, for monitoring fields, variables, and calculations
- Copy feature, for copying fields or tables. You can also import table schema for use within the same file or across different files.
- Custom Menus feature, for creating customized menus for the solution
- Custom Functions feature, for creating custom functions for use anywhere within the solution

About this guide

This Development Guide includes information about features that are available with FileMaker Pro Advanced. In addition, this guide gives an overview of how to create custom layout themes and external function plug-ins.

See FileMaker Pro Help for detailed information on product features.

To send your feedback on this guide, visit www.filemaker.com/company/documentation_feedback.html.

To access resources on the FileMaker website such as ready-made solutions and the FileMaker Knowledge Base, choose Help menu > Resource Center.

To learn more about FileMaker Pro and discuss support topics with other customers, visit the FileMaker Forum. Choose Help menu > FileMaker Forum.

Using the FileMaker Pro Advanced documentation

This Development Guide is one component in a comprehensive documentation suite provided with FileMaker Pro Advanced. FileMaker Pro Advanced also includes an online Help system to provide details on FileMaker Pro features.

This guide assumes that you are familiar with FileMaker Pro or FileMaker Pro Advanced, and that you have created a database solution that you want to work on using the FileMaker Pro Advanced features. If you are new to the FileMaker family, start with the FileMaker Pro User’s Guide.
The following manuals are included:

- **FileMaker Pro Advanced Development Guide** (this manual): describes how to use the features available in FileMaker Pro Advanced
- **Installation and New Features Guide for FileMaker Pro and FileMaker Pro Advanced**: contains installation instructions and a list of the new features in the current version
- **FileMaker Pro User’s Guide**: contains key concepts and basic procedures
- **FileMaker Pro Tutorial**: contains step-by-step lessons that teach you how to create and use FileMaker Pro databases
- **FileMaker Pro Advanced Database Design Report XML Output Grammar** manual: describes the FileMaker Pro Advanced Database Design Report (DDR) XML output grammar for users who want to create tools that analyze or process the structure of databases
- **FileMaker Instant Web Publishing Guide**: describes how to make FileMaker Pro and FileMaker Pro Advanced databases accessible to web browser users over an intranet or the internet
- **FileMaker ODBC and JDBC Guide**: describes how you can use FileMaker software as an ODBC client application and as a data source for ODBC and JDBC applications.

**Where to find PDF documentation**

To access PDFs of FileMaker documentation:

- in FileMaker Pro Advanced, choose Help menu > Product Documentation
- visit www.filemaker.com/documentation for additional documentation

Most PDF manuals are located in the folder where you installed FileMaker Pro Advanced. If you installed FileMaker Pro Advanced in the default folder location, the PDF manuals are located here:

- **Windows**: C:\Program Files\FileMaker\FileMaker Pro Advanced\English Extras\Electronic Documentation
- **Mac OS**: Macintosh HD/Applications/FileMaker Pro Advanced/English Extras/Electronic Documentation

All of the PDF files use the tagged Adobe Portable Document format (PDF). Tagged PDF files work with assistive technology such as the screen readers JAWS and Window-Eyes for Windows. For more information about tagged PDF files, see the Adobe website at www.adobe.com.

**Abiding by the license agreement for runtime solutions**

The FileMaker Pro Advanced license agreement allows you royalty-free distribution of an unlimited number of FileMaker Pro runtime database solutions. However, there are several terms and conditions in the license agreement you must abide by, including the following:

- You must provide all of the end-user technical support.
- You must provide an “About” layout that includes your name, address, and the telephone number for your technical support. For more information about creating an About layout, see the next section.
- You must read and agree to the terms and conditions of the FileMaker Pro Advanced license agreement, available through the FileMaker Pro Advanced installer, before using the FileMaker Pro Advanced software.
Your responsibilities as a developer

FileMaker has established procedures for repairing files. If a customer complies with these procedures, then FileMaker may supply a repaired file to the customer.

If you distribute database files with passwords or you have removed full access privileges and do not want FileMaker to repair a file for a customer who requests this service, you must:

1. Notify your customers in writing and keep a record of such notice that your database solution contains passwords or data that can only be provided by you.

2. Every file in your runtime database solution must contain an About layout accessible from any layout in the database.

3. The layout name must begin with the word “About.”

4. The About layout must contain these items:
   - solution name
   - your company name and contact information
   - your support policy (for example, how and when you are available for technical support)

5. The About layout must contain this exact warning:
   “USER WARNING: This database solution contains password(s) that can only be provided by the Developer identified above.”
   For more information about creating an About layout, see Help.

6. If full access privileges have been permanently removed from your database solution by selecting the Remove admin access from files permanently option in the Developer Utilities, then the About layout must contain this exact warning:
   “USER WARNING: This file is not customizable. Contact the above named Developer for information on customizing this database solution.”

The accounts and privileges protection in a FileMaker file should not be viewed as an absolute barrier that will prevent a customer from accessing files. FileMaker cannot guarantee that a customer will not be able to identify or bypass the password through third-party solutions or tools. Therefore, FileMaker recommends that you take appropriate steps to protect your consulting and development efforts without relying solely upon the password. For more information about accounts and privileges, see Help.

If you have a dispute with your customer, you must resolve this dispute directly with the customer. FileMaker is unable to, and will not, attempt to resolve such disputes.
Chapter 2
Creating database solutions

FileMaker Pro Advanced provides Developer Utilities that let you:

- rename a set of database files and automatically update the internal links to related files and scripts
- bind your database files into a stand-alone runtime database solution that does not require FileMaker Pro or FileMaker Pro Advanced in order to be used on a computer
- remove administrative access from all accounts and prevent users from modifying most design or structural elements of your databases
- display your database files in Kiosk mode
- add the FileMaker Pro filename extension to your files


Using the Developer Utilities

To customize your database files or bind the files to a runtime solution:

1. Close all of your database files that you are going to customize.
2. Choose Tools menu > Developer Utilities.
3. If you have used the Developer Utilities on the same database before and saved your settings, click Load Settings.
   A dialog box opens so that you can browse to find your settings file.
4. Click Add to locate the files that you want to customize.
5. If you are binding multiple files into a runtime solution, double-click a file in the list to specify the primary file.
6. To rename a file, select the file in the list, type the new name in the Rename file box, and click Change.
7. To remove a file, select the file in the list and click Remove.
8. Under Project Folder, click Specify to choose the location in which the copy of the database solution will be saved.
9. If you do not want the new files to overwrite earlier versions, clear Overwrite matching files within the Project Folder.

Important If Overwrite matching files within the Project Folder is selected, the Developer Utilities will overwrite files with the same names as those in the list of files.
10. Do one of the following:

- If you want to create a copy of your database files with new names, click **Create**.

  **Note** FileMaker Pro Advanced automatically updates internal links to related files and scripts.

- If you want to further customize your database files or bind the files, under **Solution Options**, click **Specify**.

11. In the Specify Solution Options dialog box, select one or more options:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Bind databases to runtime applications | Select **Create Runtime solution application(s)**.  
  **Note** This option can be combined with all others, except **Databases must have a FileMaker file extension**.  
  See “About creating runtime solutions” on page 11. |
| Permanently prohibit any administrative access to your solution | Select **Remove admin access from files permanently**.  
  **Important** Once removed, administrative access cannot be restored to the custom solution.  
  For more information about removing Admin access to databases, see Help. |
| Force accounts without full access privileges to open your solution in Kiosk mode | Select **Enable Kiosk mode for non-admin accounts**.  
  See “Creating Kiosk solutions” on page 17. |
| Add the FileMaker extension to the filenames of database files | Select **Databases must have a FileMaker file extension**.  
  **Note** This option is not available if you select **Create Runtime solution application(s)**.  
  You can use this feature to add extensions to files that do not have extensions. |
| Create a log file to record any errors encountered during processing | Select **Create Error log for any processing errors**.  
  Specify a location and a filename for the error log.  
  **Notes**  
  - If you don’t specify a filename and location for the error log, it will be saved to the project folder with the filename Logfile.txt.  
  - If an error occurs during the processing of the options, the error is logged in the error log. An error message may also indicate that an error has been encountered. |

12. Click **OK**.

13. To be able to quickly repeat the process, click **Save Settings**, and choose a folder and location for your settings file. For more information about saving solution settings, see Help.

14. Click **Create**.
About creating runtime solutions

Use the Developer Utilities to produce a stand-alone runtime database solution that users can access without running FileMaker Pro or FileMaker Pro Advanced. The Developer Utilities create a copy of your files, and bind the database file or files to a runtime application with a name that you specify.

Runtime applications do not have all the functionality and features of FileMaker Pro. For a complete list of the differences between the runtime application and FileMaker Pro, see appendix A, “Feature comparison of the runtime application with FileMaker Pro.”

You may need to bind your database files several times before you prepare them for delivery to your users. When you have completed development and the final version is bound and ready to distribute, you should thoroughly test your runtime solution to ensure that it behaves as expected.

Note  FileMaker Pro and FileMaker Pro Advanced allow you to include as many database tables as you need in a database file. This capability eliminates one of the main reasons for using multiple files. However, other elements, like scripts and access privileges, are stored at the file level and so some complex solutions will still benefit from using multiple files.

Before you begin to build your database solution, you need to decide how users will interact with it. Your database solution might have any of the following components:

- a primary database file that connects all of the auxiliary files
- scripts and buttons to open and close auxiliary files, return to the primary file, display a splash screen layout at startup, or quit a runtime application
- common elements and a consistent appearance for cross-platform solutions
- tooltips and custom menus
- a custom layout theme used for every file in the solution
- an About layout to introduce your solution (required)
- a custom Help system that provides usage tips for your solution
- multiple privilege sets that can specify levels of access to layouts, menus, specific tables, record, fields, and so on
- password-protected accounts assigned to privilege sets that determine the level of access of account users

For information about what users need in order to use your runtime database solution, see “Distributing runtime solutions” on page 13.

Converting and upgrading previous solutions

If you have developed a FileMaker Pro runtime database solution using the Solutions Development Kit (SDK) for FileMaker Pro 3.0 or earlier, the Binder utility in the FileMaker Pro 4.0 Developer Edition, or the Developer Tool in FileMaker Developer 5.x and 6.0, you can upgrade your solution and provide your users with the converted files. Files bound to a runtime application using the earlier tools must be rebound using the Developer Utilities.

You must convert FileMaker Pro files created in version 6.0 or earlier to the new file format. You can convert a single file or convert multiple files at once. For more information about converting files, see Help.
Once you have converted the files, you can upgrade them to take advantage of newer FileMaker Pro and FileMaker Pro Advanced features. If necessary, create scripts to import users’ existing data from the old runtime database solution into the new, upgraded solution. See Help for more information on importing data into upgraded runtime solutions. Use the Developer Utilities to bind the solution files into a new, upgraded runtime database solution.

Distribute the new upgraded runtime database solution and provide instructions for how users can upgrade their files by converting the old files in the new runtime application and importing their data.

**Binding the solution**

To bind database files into a runtime database solution:

1. Follow the procedures in “Using the Developer Utilities” on page 9.
2. In the Specify Solution Options dialog box, select **Create Runtime solution application(s)**.
3. To name your runtime application:
   - For **Runtime Name**, type a name. The name is used for the runtime application filename and for the name of the folder that contains the runtime database solution files.
   - For **Extension**, type a three-character filename extension. The extension is used to associate the solution files with the runtime applications.

   For more information about naming runtime solutions, see Help.

4. For **Bindkey**, type a key between 1 and 24 characters long.

   The binding key links the runtime application to the database files and ensures that the bound files will only open in the appropriate runtime application. The binding key is case-sensitive. For more information on setting the binding key, see Help.

   **Important** Binding installs system files pertaining to each platform. If your solution will be used in Windows, bind it using the Developer Utilities for Windows. If your solution will be used on Mac OS X, bind it using the Developer Utilities for Mac OS X. If you’re creating a solution to be used on both Windows and the Mac OS X, create two separate runtime solutions by binding the original solution files twice: first using FileMaker Developer Utilities for Windows, and then using FileMaker Developer Utilities for Mac OS X. Use the same binding key on both platforms.

5. To add a company logo or other custom image to the closing splash screen, click **Specify**, select the closing image, and click **Select**.

   The image should be at least 32 x 175 pixels (72 dpi) or higher, otherwise it will be distorted when displayed. The supported image formats are JPEG and GIF.

6. For **Delay**, set the number of seconds that you want the splash screen to display.

   You can preview the effect that your custom splash screen will have by clicking the **Preview** button.

7. Once you have specified options, click **OK**.

8. To be able to quickly repeat the process, click **Save Settings**, and choose a folder and location for your settings file.

   For more information about saving and reusing Developer Utilities settings, see Help.
9. Click Create.

The Developer Utilities copy all of the runtime files to a new folder created inside the Project Folder and named after the runtime solution.

**Starting runtime database solutions**

![Double-click to start](image1) ![Solution file icon](image2)

**Important** Your users should start your solution by double-clicking the runtime application icon, not the solution file icon. Double-clicking the icons for the solution or auxiliary files might result in errors, depending on whether there are other copies of the runtime application on their hard disk. If your users have more than one solution on their computers associated with the same three-character extension and they double-click the icon for the solution file, the first solution installed will attempt to open the file, and this might not be the correct application for the specific file.

**Distributing runtime solutions**

The final steps in developing your runtime database solution are to bundle all of the necessary files together, choose how you will distribute your solution—for example, on a CD-ROM or over a network—and provide your users with documentation for installing your solution. In addition, your documentation should include instructions for starting the runtime application and what to do if a file is damaged.

**Important** Windows: The proper method for distributing Runtime solutions (including the executable) is to use Installer software. This software must install components in the proper location in the Windows filesystem and provide an uninstall capability. See the Microsoft website for information about the location of installed files as well as location restrictions. Note that Windows Vista imposes specific restrictions, requiring some runtime components—for example, Microsoft Visual C++ 2008 SP1 Redistributable Package (x86)—be located in a location in which only an Installer can write.

**Organizing solution components**

When you bind your database files into a runtime database solution, the Developer Utilities create a new solution folder and place the runtime application, the bound primary and auxiliary database files, and an Extensions folder inside it. For Windows runtime solutions there are also required Dynamic Link Library (DLL) files.

**Note** When you move multiple files into one folder to create a runtime solution, be aware that your internal links are affected. For this reason, every data source must include a path that is just the filename of the file being referenced. Although the runtime application will check other data sources, it will then be able to find the file in the same folder in which it resides. You can still keep any absolute or relative paths in the same data source reference in case the files are also used in FileMaker Pro or FileMaker Pro Advanced.
Important  These files and folders must not be renamed.

For details on the contents of the Mac OS X runtime application package and the Windows Extensions folder and DLLs, see Help.

If your runtime database solution requires custom files, you should provide the files with the runtime files. Plug-ins should be stored in the Extensions folder. If a developer uses a font not found on a user’s system, the runtime application will make a font substitution. If a font is included with the runtime, provision should be made for its installation through the installer program. See “Using a custom installation program” below.

In addition to the runtime files, you will need to provide installation instructions for your users. For more information on documenting developer solutions, see Help.

Choosing a distribution method

After you have organized the files that comprise your solution, you need to decide how your users will install them. You can distribute your bundled solution on a CD-ROM, over a network, or via the internet. In order to run your runtime database solution, your users will need the same minimum equipment and software required by the FileMaker Pro Advanced application.

Using a custom installation program

You should use a custom installation program to package your runtime solution for installation by users. Configuring a custom installation application to install runtime database solution files may require more engineering than using a compression utility, but will help to ensure that your users do not have difficulties installing your runtime solution.

Here are some custom installation applications you might want to use:

- MindVision Installer VISE
- InstallShield MultiPlatform
- MacInstallerBuilder
Using a compression utility program

If your runtime database solution is not complex and you have confidence in the technical experience of your end users, you might consider a compression utility program rather than a custom installation program.

Sharing solutions over a network

Users cannot share your runtime database solution over a network unless they access the files using FileMaker Pro or FileMaker Pro Advanced installed on their machines. You must have a master password to enable or change network access to the file. For optimal performance, you can host the solution files using FileMaker Server.

For information about the FileMaker Server and FileMaker Pro products, and information about volume license sales, visit the FileMaker website at www.filemaker.com.

Recovering damaged files

Power failures, hardware problems, or other factors can damage a FileMaker database file. If your database solution becomes damaged, your users will need to recover the damaged file. When the runtime application discovers a damaged file, a dialog box appears, telling the user to contact the developer. Even if the dialog box does not appear, files can become corrupted and exhibit erratic behavior.

For information about recovering runtime files, see Help.

Creating an About layout

For runtime database solutions, the FileMaker Pro Advanced license specifies that you must create an About layout that provides information for your users on how to contact you for technical support. FileMaker uses the About layout to distinguish databases created by developers using FileMaker Pro Advanced rather than users of FileMaker Pro.

For more information about what is required to appear in the About layout for runtime database solutions, see “Your responsibilities as a developer” on page 7.

Creating a custom Help layout

The FileMaker Pro Advanced Help system is not available in runtime applications.

Create a Help layout that provides instructions for how to use your custom solution and add data to it. Then create a script in the primary file of your solution to display the Help system. Use the custom menus feature to make the script available as a command in the Help menu.

To create a web page to document your solution, put a web viewer in your Help layout that opens the web page.

To display your custom Help menu on Mac OS, you must start with an empty menu. For more information about creating and editing custom menus, see “About custom menus” on page 20.
Testing before and after creating your solution

You should verify the functionality of your database solution by testing it thoroughly before and after you customize it with the Developer Utilities.

To ensure the quality of your custom database solution:

- Verify every function and option in your solution. If you’re developing a solution for both platforms, test it on both Windows and Mac OS X platforms.
- Make sure your runtime database solution does not use a standard FileMaker Pro feature that is hidden or disabled in the runtime application. See appendix A, “Feature comparison of the runtime application with FileMaker Pro.”
- Verify that all scripts and buttons work as expected. This is especially important if you’re displaying your solution in Kiosk mode. See “Creating Kiosk solutions” on page 17.
- Verify your installation procedures and test other instructions in the documentation.
- Verify that your database layouts display well on monitors with different color capabilities and resolutions and on the smallest size monitor your users may be using.
- Test your runtime database solution with actual data. This is especially important if users are upgrading from earlier versions of the runtime application and need to import data into new solution files.
- Make sure all the auxiliary files and DLLs (Windows) are present.
- Show your database solution to intended users to uncover any usability issues.
- Install your bundled database files on a completely different computer to verify that all the files associated with the primary file can be found.
- If you’re assigning passwords or permanently removing full access privileges, test all access levels.
- Make sure your database solution contains an About layout that notifies users of the level of access you’re providing.

Important You should keep an unbound version of any runtime database solution files, especially if you’ve permanently removed full access privileges.

Distributing updates to runtime database solutions

If you make feature enhancements or modifications to the primary bound file of your runtime database solution, you can distribute the updated file to your users without rebinding it. If you change the filename of the primary file, however, you’ll need to rebind the file and distribute a new version of the runtime application along with the updated file.

To distribute new or updated auxiliary files for your runtime database solution, bind them first using the original binding key. If you are distributing a new auxiliary file that requires new data sources in the main file or that requires other files to interact with it, you must update all files that have been modified.

If you forget the original binding key for your runtime database solution and want to update or add a file, you’ll need to rebind all of the database files with a new binding key and redistribute the entire solution.

To distribute an updated primary file:

1. Open the original primary file from your copy of the runtime solution in FileMaker Pro Advanced.
2. Make the changes to the primary file.
3. If necessary, create an Import script so users can import their existing data into the new primary file. For more information about importing data into upgraded runtime solutions, see Help.

4. Send your users a copy of the new primary file with instructions to replace the old primary file in the runtime database solution folder.

To distribute a new or updated auxiliary file:

1. In FileMaker Pro Advanced, create the new auxiliary file or open the original auxiliary file (before it was bound) and make changes as required.

2. If necessary, create an Import script so users can import their existing data into the new file. For more information about importing data into upgraded runtime solutions, see Help.

3. Use the Developer Utilities to rebind all of the files in the runtime database solution and include the new or updated auxiliary file. Use the same binding key that you used for the primary file.

4. Send your users a copy of the new or updated auxiliary file along with instructions to place it in the runtime database solution folder, replacing the old file if appropriate.

As long as the binding key has not changed, you don’t need to redistribute the runtime application or other solution files.

**Creating Kiosk solutions**

Kiosk mode is a way of displaying your database solution or your runtime database solution on a full screen, without any toolbars or menus. As the name suggests, Kiosk mode can be used to present your database to users as an information kiosk. You can design your database to run through a touch screen.

Kiosk mode is ignored if the solution is opened by accounts with the Full Access privilege set, a privilege set that allows management of extended privileges, or a privilege set that allows modification of layouts, value lists, and scripts.

For your solution to display in Kiosk mode, you must:

- create an account with a limited privilege set or create a specific Kiosk account.
- enable Kiosk mode. At the same time that you enable Kiosk mode, you can bind the database as a runtime solution.
- clear the default option of logging into the file with the Admin account.

To create a Kiosk account:

1. Ensure you have a limited access account.

2. With the database solution open, choose File menu > Manage > Accounts & Privileges.

3. In the Manage Accounts & Privileges dialog box, click New.

4. In the Edit Account dialog box, type an account name, click Active for the Account Status, and select New Privilege Set from the Privilege Set list.
5. In the Edit Privilege Set dialog box, give the privilege set a name and description.

6. For Layouts, Value Lists, and Scripts, select either All view only or All no access.

7. Clear the Manage extended privileges checkbox.

8. Select other options as required and click OK.

To enable Kiosk mode:

1. Follow the procedures in “Using the Developer Utilities” on page 9.

2. In the Specify Solution Options dialog box, select Enable Kiosk mode for non-admin accounts.

3. Select other options as required click OK.

4. To be able to quickly repeat the process, click Save Settings, and choose a folder and location for your settings file.
   For information on saving solution settings, see Help.

5. Click Create.
   If you did not bind the files to a runtime application, the Developer Utilities copy the selected database files to the Project Folder. If you did bind the files to a runtime application, the Developer Utilities copy all of the runtime files to a new folder created inside the Project Folder and named after the runtime solution.

To change the default option of logging into the file with the Admin account:

1. With the database solution open, choose File menu > File Options.

2. On the Open/Close tab, clear Log in using.

3. Click OK.

When you create a solution to run in Kiosk mode, you need to provide navigation for your solution and the ability for users to quit your solution.

Note If you have a previous Kiosk solution that displayed the status area, you will need to update your solution. You cannot display the status toolbar or layout bar in a Kiosk solution. You will need to add record navigation, script paused status, and script Cancel and Continue buttons to your layouts.

For more information on using scripts and buttons to control Kiosk solutions, see Help.
Chapter 3

Customizing database solutions

You can use FileMaker Pro Advanced to customize your solutions beyond what is possible with FileMaker Pro. You can:

- copy and paste fields for use within the same file or other database files
- copy or import existing tables into your database file
- create custom functions for use anywhere within a file
- create custom menus
- create custom layout themes

Important You must have full access privileges to customize database solutions.


Copying or importing field and table schemas

You can copy or import field and table schemas within a file or to other database files.

With FileMaker Pro Advanced, you can consolidate tables from a multi-file solution into one file. There are two methods for consolidating solutions:

- Copy table schemas — Open source files to select and copy the tables you want. Then, paste the table schemas into the destination file.
- Import table schemas — Import table schemas directly into the destination file. You can import just the schemas or import data with a single schema. (To import the data with a single schema, choose File menu > Import Records > File.)

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy a field schema</td>
<td>Choose File menu &gt; Manage &gt; Database &gt; Fields tab. Select the field from the list, then click Copy. Data is not copied.</td>
</tr>
<tr>
<td>Copy a table schema</td>
<td>Open the file that contains the table you want to copy. Choose File menu &gt; Manage &gt; Database &gt; Tables tab. Select the table from the list, then click Copy.</td>
</tr>
<tr>
<td>Import a table schema</td>
<td>Open the file into which you want to import a table. Choose File menu &gt; Manage &gt; Database &gt; Tables tab. Click Import. Select the source file and table, and click OK.</td>
</tr>
</tbody>
</table>

For more information about copying or importing fields and tables, see Help.
Creating custom functions

Use the Custom Functions feature to create custom functions that can be reused anywhere in a database file and copied or imported to other FileMaker Pro files. Once formulas are written for the function, they don’t have to be rewritten to be applied to other fields or used in other scripts.

You can maintain and edit custom functions and the formulas they contain in one central location. Any change made to the custom function will be copied to all instances where that custom function has been used.

To create a custom function:

1. Choose File menu > Manage > Custom Functions.

2. In the Manage Custom Functions dialog box, click New.

3. In the Edit Custom Function dialog box, type a name for the function and build a formula.

4. Click OK.

For more information about creating custom functions, see Help.

About custom menus

With FileMaker Pro Advanced, you can create custom menus, menu items, and menu sets for your database solutions. You can:

- create a menu or edit an existing menu
- duplicate or delete a menu
- add, duplicate, or delete menu items
- specify menu item properties, such as display title, shortcut, and action.
You can customize menus by:

- editing a copy of a standard FileMaker menu. Use this method to make minor changes to existing menus, for example, to modify the properties of a few menu items.
- starting with an empty menu. Use this method to make significant changes to menus, for example, to add menus and change menu item properties.

**Custom menu example**

The following example shows how to customize the New Record menu item that appears in the Records menu. Here we rename the New Record menu item to New Invoice, then attach a script that runs when the user chooses the New Invoice menu item. Finally, we change the default menu set so the new custom menu set displays when a user opens the database.

This example assumes the database contains a script called My New Invoice. My New Invoice automates several tasks, like switching to the Invoices layout and creating an empty record.

1. Open the database and choose File menu > Manage > Custom Menus > Custom Menus tab.
2. Double-click the Records Copy menu to edit a copy of the standard Records menu.
3. Select the New Record menu item to modify its properties. Under Override default behaviors:
   - Select Item Name and type New Invoice.
   - Select Action and specify the My New Invoice script.
4. Click OK.
The custom menu item is used in Custom Menu Set 1 by default. To see the custom menu item in FileMaker Pro:

1. For Default menu set for this file, select Custom Menu Set 1, then click OK to close the Manage Custom Menus dialog box.

2. Choose the Records menu.

   The New Invoice menu item appears at the top of the Records menu.

---

**Creating custom menus**

To create a custom menu:

1. Choose File menu > Manage > Custom Menus > Custom Menus tab.

   You see the Manage Custom Menus dialog box.

2. Click Create.

3. In the Create Custom Menu dialog box, do one of the following, then click OK:
   - Click Start with an empty menu.
   - Click Start with a standard FileMaker menu, then select a menu from the list.

   The Edit Custom Menu dialog box appears.

4. In the Edit Custom Menu dialog box, specify a custom menu name, a comment that describes the menu (optional), the menu title that you want to display in the menu bar, and the operating system platform and FileMaker Pro modes in which the menu is to appear. See Help for more information on these options.

   **Note** The comment appears in the Manage Custom Menus dialog box, not in your solution file.

5. Create custom menu items, as described in the following section.
Creating custom menu items

After you create a menu, you can create menu items. You can also create or edit menu items that are copies of the Standard FileMaker menus. Menu items can be commands, submenus, or separators. You can create a menu item that is based on a standard FileMaker command or you can create a menu item that initially does not have an assigned command.

When you base a menu item on a FileMaker command, the menu item inherits all the properties of that command. You can override properties (menu item name, keyboard shortcut, or action) to customize the menu item.

When you create a menu item that does not have an assigned command, an <unknown> menu item appears in the Menu Items list in the Edit Custom Menu dialog box. You can then customize this menu item’s properties.

To create a new menu item:

1. Choose File menu > Manage > Custom Menus > Custom Menus tab.

2. In the Manage Custom Menus dialog box, select the menu to which you want to add the menu item, then click Edit.

3. In the Edit Custom Menu dialog box, specify which menu items are included in the menu:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a command</td>
<td>Click Create to add a new &lt;unknown&gt; menu item to the list. For Menu Item Type, choose Command, then select Based on an existing command. In the Specify FileMaker Command dialog box, choose a command, then click Select. A command determines the action or behavior of a menu item.</td>
</tr>
<tr>
<td>Add a submenu</td>
<td>Click Create to add an &lt;unknown&gt; menu item to the list. For Menu Item Type, choose Submenu, click Specify, select a menu, and click Select.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> You can add up to 100 menus to the menu bar. If you add a menu that includes itself as a submenu, you may quickly reach the limit.</td>
</tr>
<tr>
<td>Add a separator line</td>
<td>Click Create to add an &lt;unknown&gt; menu item to the list. For Menu Item Type, choose Separator.</td>
</tr>
<tr>
<td>Duplicate a menu item</td>
<td>Select a menu item from the list, then click Duplicate.</td>
</tr>
<tr>
<td>Delete a menu item</td>
<td>Select a menu item from the list, then click Delete.</td>
</tr>
</tbody>
</table>

Drag an arrow † up or down to change the order of the menu items in the list.
To change the properties of a menu item:

1. Select a menu item from the Menu Items list and do one or more of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change a command for a menu item</td>
<td>For Based on an existing command, click Specify, choose a different command, then click Select.</td>
</tr>
<tr>
<td>Change a menu item from one type to another</td>
<td>For Menu Item Type, choose a different type. (For example, you can change a separator to a command.)</td>
</tr>
<tr>
<td>Change the name of a menu item</td>
<td>Select Item Name and enter a new name.</td>
</tr>
<tr>
<td></td>
<td>To base the menu title on the result of a calculation, click Specify, then build a formula in the Specify Calculation dialog box.</td>
</tr>
<tr>
<td></td>
<td>Windows: To specify an access key, type an ampersand (&amp;) before the character you want to use as the access key. For example, type &amp;Open to display the Open menu item with the letter “O” as the access key.</td>
</tr>
<tr>
<td>Define a keyboard shortcut for a menu item</td>
<td>Select Keyboard Shortcut. In the Specify Shortcut dialog box, type a key combination, then click OK. Keyboard shortcuts appear next to menu items in the Menu Items list. For more information about keyboard shortcuts, see Help.</td>
</tr>
<tr>
<td>Perform a script or script step when a user selects a menu item</td>
<td>Select Action. In the Specify Script Step dialog box, select a step and specify options as necessary, then click OK.</td>
</tr>
<tr>
<td></td>
<td>Note To affect the behavior of a currently running script (for example, to halt, exit, resume, or pause the script) use the Perform Script script step.</td>
</tr>
<tr>
<td></td>
<td>For more information about scripts and script steps, see Help.</td>
</tr>
<tr>
<td>Change a script or script step</td>
<td>For Action, click Specify, modify the script definition, then click OK.</td>
</tr>
<tr>
<td>Choose a platform for a menu item</td>
<td>Select Windows or Macintosh or both. Your menu item will appear in FileMaker Pro files running in the platforms you specify.</td>
</tr>
<tr>
<td></td>
<td>Note Some commands are valid on only one platform.</td>
</tr>
</tbody>
</table>

2. Click OK.

**Creating custom menu sets**

Custom menu sets are collections of menus that appear in the FileMaker Pro application menu bar. You can create custom menu sets to include only the menus you require. After you create menu sets, you can:

- specify menu sets for individual layouts
- create scripts that change menu sets
- change the default menu set in a solution file’s menu bar
- switch menu sets temporarily using the FileMaker Pro Advanced Tools menu
To create or edit menu sets:

1. Choose File menu > Manage > Custom Menus > Custom Menu Sets tab.
2. Click Create.
3. In the Edit Custom menu set dialog box, click Add to specify which menus to include in the menu set.

<table>
<thead>
<tr>
<th>To:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a menu to this menu set</td>
<td>Click Add, do one of the following in the Select Menu dialog box, then click Select:</td>
</tr>
<tr>
<td></td>
<td>• Choose a menu from the list.</td>
</tr>
<tr>
<td></td>
<td>• Click + to create a new menu. For more information, see “Creating custom menus” on page 22.</td>
</tr>
<tr>
<td>Tips</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• You can Shift-click or Ctrl-click (Windows) or Command-click (Mac OS) additional menus to add multiple menus to the menu set.</td>
</tr>
<tr>
<td></td>
<td>• Click – to remove a custom menu in the Select Menu dialog box.</td>
</tr>
</tbody>
</table>

4. Click OK to return to the Manage Custom Menus dialog box.

**Tip** To change the default menu set for this file, select Default menu set for this file and click OK. You see the new menu set in FileMaker Pro.

For more information about creating, installing, and testing custom menu sets, see Help.

**Creating custom layout themes**

FileMaker Pro and FileMaker Pro Advanced use a variety of layout themes to describe the colors, patterns, fonts, and borders of text, fields, and parts in a new layout.

A theme is an Extensible Markup Language (XML) document that can be read and edited in a text editor (such as Notepad for Windows or BBEdit for Mac OS X) or XML editor (such as XMLSpy or XMetaL). You can customize an existing theme or create your own, and then use the New Layout/Report assistant to apply the custom theme when you create layouts for your databases. You can modify attributes defined by the theme in Layout mode after the layout is created. However, you can’t apply a theme to an existing layout.

**Note** A FileMaker theme is not a stylesheet and does not contain positioning information for objects on a layout.

**Important** The XML for a layout theme must be well-formed and comply with the required syntax. Omitting a required element or attribute, or mismatching start and end tags will result in an unusable document and FileMaker Pro Advanced will be unable to parse the XML or display the theme in the New Layout/Report assistant.
To create or modify a theme:

1. Make a copy of one of the theme files in the Themes folder.
   - Windows: FileMaker Pro Advanced\Extensions\English\Themes\ or
   - Mac OS X: FileMaker Pro Advanced/FileMaker Pro Advanced.app/Contents/Resources/English.lproj/Themes/

   **Important** The total number of theme files is limited to 50.

2. Rename the copy and include the .fth extension with the new filename.
   Keep the new file in the Themes folder. In order for the New Layout/Report assistant to display a theme option, the theme file must reside in the Themes folder and it must have the .fth filename extension.

3. Open the theme file in a text editor.
4. Change the name of a theme by replacing the value of the ThemeName element with a new name.
   
   `<ThemeName Value="Purple and White Screen" />
   
   Important If your ThemeName value contains any upper-ASCII characters, use the HINT attribute to ensure that the theme name will appear on both the Windows and Mac OS X platforms.

5. Change the values of other elements and attributes.
   For example, to change the background fill color of the body part in a layout to a light purple, change the color hexadecimal (hex) value to #9933CC:
   
   `<BodyPart>
       <Fill Color="#9933CC" Pattern="2" />
   </BodyPart>

6. Remove any elements that you don’t want to specify.
   Be sure to remove the entire single-line or multi-line element including its start and end tags.

7. Scroll down to the next FMTHEME element and repeat these steps to change the ThemeName value and other elements.

8. Save the file in text format with the filename extension .fth in the Themes folder.
   Each new ThemeName value will appear in the New Layout/Report assistant as a Layout Theme option.

   Follow the instruction in the New Layout/Report assistant. Names of custom themes appear as options. The third panel presents you with a list of themes to select from.
   If your new themes don’t appear in the New Layout/Report assistant, you might have made a syntax error.

Requirements for theme files

Every theme file must begin with an XML-document processing instruction that declares it as an XML document using the XML 1.0 specification. In addition, an XML document for a layout theme must contain the <FMTHEMES> and </FMTHEMES> start and end tags for the file. This FMTHEMES root element can contain one or more FMTHEME elements.

For more information on theme elements and attributes, see Help.
Chapter 4

Debugging and analyzing files

The FileMaker Pro Advanced features explained in this chapter are:

- the Script Debugger for systematic testing and debugging of FileMaker scripts
- the Disable script step feature for testing portions of a script
- the Database Design Report feature for publishing comprehensive documentation on database schema and options
- the Data Viewer for monitoring fields, variables, and calculations

**Note**  See Help for detailed, comprehensive information and step-by-step procedures for using FileMaker Pro Advanced.

**Debugging scripts**

With FileMaker Pro Advanced, you can use the Script Debugger to:

- debug scripts that are run from the Scripts menu or keyboard shortcuts
- debug startup scripts (the Script Debugger menu is enabled even if there are no open files)
- debug a script activated by a script trigger, button, or custom menu
- step through scripts one step at a time
- view and track sub-scripts
- monitor fields, variables, and calculations
- disable script steps
- debug restricted-access scripts
- pause a script when script errors are encountered
- click a script error number to open a Help topic

To run scripts in debug mode:

1. Select **Tools** menu > **Script Debugger**.
   The Script Debugger dialog box opens.
2. Run your script.
You can view sub-scripts when you step through scripts in the Script Debugger. For example, if Script A calls Script B, which then calls Script C, you can view the steps in all three scripts.

The Script Debugger recognizes the privileges attached to each script. A script will only appear in the Script Debugger if you have editing privileges for the script and the access privileges for the script are set to Modifiable. You can click Authenticate/Deauthenticate script to log in and edit script steps in restricted-access scripts.

In the Script Debugger window you can select more than one step from the step list, enabling you to place simultaneous multiple breakpoints on steps. If multiple steps are selected, the Set Next Step button will be disabled.

**Notes**

- You can’t set breakpoints on script steps called by buttons or custom menus.
- When you use the Script Debugger to step through scripts activated by a script trigger, you will not be able to interact with the document windows, move between fields or records, change the data, close the window, or quit. This blocking of interaction only occurs when a script is triggered via some action. When you are debugging a script that is not activated by a script trigger you can interact normally with the document windows, fields, and records. For more information about using script triggers, see Help.

**Tip** To enable the Script Debugger from the Manage Scripts dialog box, press Shift and click the Perform button. To disable the Script Debugger, press Ctrl (Windows) or Command (Mac OS) and click the Perform button.

**Disabling script steps**

You can disable and enable script steps to test portions of a script. When you run a script, disabled script steps are skipped.

To disable script steps:

1. Choose Scripts menu > Manage Scripts.
   Or, choose File menu > Manage > Scripts.
2. In the Manage Scripts dialog box, double-click the script name.
   Or, click the Edit button in the Script Debugger dialog box.

3. In the Edit Script dialog box, select one or more script steps, then click Disable or Enable.

For more information about debugging scripts, see Help.

**Using the Data Viewer**

You can use the Data Viewer to monitor expressions like field values, local and global variables, and calculations. You can monitor these expressions while running scripts or while testing them in the Script Debugger.

The Current tab shows the fields and variables that are in the currently running script, fields that are referenced in calculations used in the script, and global variables. The Watch tab monitors expressions that you entered until you remove them from the list.

To monitor fields, variables, and calculations:

1. Choose Tools menu > Data Viewer, or click the Open/Close Data Viewer button in the Script Debugger window.

2. In the Current tab, double-click a value to display a dialog box where you can:
   - View, edit, and copy local or global variables.
   - View (but not edit) field values.

3. To sort expressions, click a column heading. Expressions sort independently in this order: fields, global variables, local variables.

4. To add an expression to the Watch tab, click Add to Watch.
   The expression is copied to the Watch tab, and the Watch tab opens.

5. To view restricted-access expressions, click , then log into an account that has full access privileges.

   **Note** If you logged in to edit restricted-access scripts in the Script Debugger, your access privileges also apply to the Data Viewer. If you logged in from the Data Viewer, your access privileges also apply to the Script Debugger. In either case, your editing privileges last until you close the Script Debugger or the Data Viewer.
6. Click the Watch tab.

7. Choose one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add an expression</td>
<td>Click +.</td>
</tr>
<tr>
<td>Edit an expression</td>
<td>Select an expression, then click or double-click the expression.</td>
</tr>
<tr>
<td>Duplicate an expression</td>
<td>Select one or more expressions, then click +.</td>
</tr>
</tbody>
</table>
| Delete an expression| Select one or more expressions, then click -.

8. In the Edit Expression dialog box, select the database file containing the expression, then build or edit the expression you want to monitor.

9. Click Evaluate Now to display the results of an expression, or click Monitor to add the expression to the watch list in the Data Viewer.

10. In the Data Viewer, click Refresh Values to refresh the calculations in the list.

For more information about using the Data Viewer, see Help.
**Using the Database Design Report**

Use the Database Design Report (DDR) feature to document the schema of your database and publish it to an HTML or XML file. You can choose which elements and database tables in the database you want to report. The HTML version of the report is hyperlinked and you can view or print it in a Javascript-enabled web browser.

With the Database Design Report feature you can:

- examine a textual representation of your database schema
- gather statistics on the structure of your database
- use the information in the report to recreate the structure of your database if you lose the original database files
- troubleshoot missing references, broken relationships, calculations, and more

To create a Database Design Report:

1. Open all database files for which you want to produce a Database Design Report.
   You must have full access privileges for any file for which you want to produce a Database Design Report and the file must be open in FileMaker Pro Advanced. You can run a Database Design Report on local or remote files.

2. Choose **Tools** menu > **Database Design Report**.

3. In the **Available Files** list, clear any files that you want to exclude from the report by clearing the checkbox associated with the file.

4. If there are any files that contain tables that you want to exclude from the report, select the file in the **Available Files** list.
   The tables in the file appear in the **Include fields from tables in selected file** list. You can then deselect any table in the list.
   By default, all tables in all selected files are reported.

5. Clear elements that you want to exclude from the report.
   By default, all elements in all selected files are reported. Each selected element, if present, will be reported on for each selected file.

6. If you prefer to publish the report in XML format instead of the default HTML, select **XML** in the **Report Format** section.

7. If you do not want the report to automatically open when done, clear the checkbox for this option in the **File Handling** section.

8. Click **Create**.

For more information about using the Database Design Report, see Help.
Chapter 5

Developing third-party FileMaker plug-ins

If you are a C or C++ programmer and familiar with calculations in FileMaker Pro and FileMaker Pro Advanced, you can create external function plug-ins that extend the feature set of the applications. The plug-ins can take advantage of recursion and looping or hook into other programming interfaces. Users can enable your plug-ins in FileMaker Pro, FileMaker Pro Advanced, FileMaker Server, and FileMaker Server Advanced and use your external functions in their calculation fields and scripts.

You can use FileMaker Server to ensure that FileMaker Pro clients always have the most current plug-in software installed on their computers. See FileMaker Server Guide to Updating Plug-Ins, available on www.filemaker.com/documentation.

To see an example plug-in project, visit www.filemaker.com/support/technologies.

Making plug-ins accessible to users

Database users access your plug-ins by using external functions in the Specify Calculation dialog box. Follow these general steps to prepare your custom plug-ins:

1. Create a plug-in file containing your custom programming code.
2. Compile and test the customized plug-in.
3. Install the compiled plug-in file for your users.

External function plug-in files must be installed in the appropriate folder and enabled in FileMaker Pro, FileMaker Pro Advanced, or FileMaker Server before they can be used.

To access your external functions, instruct your users to:

1. Enable your plug-in in the Preferences dialog box in FileMaker Pro.
2. Configure your plug-in, if required.
3. Define or edit a calculation field to access external functions.
4. In the Specify Calculation dialog box, choose Function_Name(parameter 1 ...) as the calculation formula.

To see all external functions, select External functions from the View list.
Installing plug-ins

Some plug-ins (and the libraries they reference) load only when the process is executed by a user who is logged into the system; FileMaker Server executes as a service, not as a user process. Consequently, you need to write plug-ins differently to work with FileMaker Server. Users will need to see their operating system documentation to find which libraries are typically available. For information on installing web publishing plug-ins, see FileMaker Server Help.

To install a plug-in, drag the plug-in file into the FileMaker user’s Extensions folder as follows:

<table>
<thead>
<tr>
<th>On this operating system:</th>
<th>Store the plug-in in this folder:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows XP</td>
<td>C:\Documents and Settings\user_name\Local Settings\Application Data\FileMaker\Extensions\</td>
</tr>
<tr>
<td>Windows Vista or Windows 7</td>
<td>C:\users\user_name\AppData\Local\FileMaker\Extensions\</td>
</tr>
<tr>
<td>Mac OS X</td>
<td>Macintosh HD/Users/user_name/Library/Application Support/FileMaker/Extensions</td>
</tr>
</tbody>
</table>

In Windows, the plug-in extension must be .fmx. In Mac OS X, the plug-in extension must be .fmplugin.

Enabling plug-ins

To enable a plug-in:

1. Open the Preferences dialog box.
   - Windows: Choose Edit menu > Preferences.
   - Mac OS X: Choose FileMaker Pro Advanced application menu > Preferences.
2. Click the Plug-Ins tab.
3. Select the plug-in in the list.

   A plug-in will appear in the list if it’s installed in the correct FileMaker folder. When starting, FileMaker Pro first loads the plug-ins stored in the current user’s FileMaker Extensions folder. If a particular plug-in is not found in that folder, FileMaker Pro searches for that plug-in in the Extensions folder for the FileMaker Pro application.
Configuring plug-ins

To configure a plug-in:

1. Select the plug-in in the Preferences dialog box.

2. Click Configure.
   
   The Configure button is only available when the sixth character in the option string of the selected plug-in is “Y.”

3. Follow instructions in the configuration dialog box to configure the plug-in.

4. Click OK.
Appendix A

Feature comparison of the runtime application with FileMaker Pro

When you double-click the FileMaker Pro application icon to start the application you can create a new database or choose a file to open. When you start a FileMaker Pro runtime application, the primary bound database file opens automatically.

Other key differences between the runtime application and FileMaker Pro include the following:

- All the database design features have been removed or hidden in the runtime application. This includes Layout mode and commands on the Manage submenu.
- Custom functions and custom menus created with FileMaker Pro Advanced will work in the runtime application, although users of the runtime application cannot modify or create new custom functions or custom menus.
- Some other menu commands have been removed from the runtime application. For example, you can’t use the runtime application to create, open, or close a database. (Bound runtime database files must contain a custom button or script to close or open other files. There is no close command on a runtime database window.)
- FileMaker Pro Help is not available in the runtime application. However, you can use the custom menu feature to display customized Help text that you create.
- External function plug-ins can be enabled in the Preferences dialog box.
- Although the XML Data filter appears as an option for the Convert File script step, you can’t convert XML files using this script step in a runtime application.
- FileMaker Pro File Sharing, serving a database on the web, or communicating with a Java applet requires FileMaker Pro or FileMaker Pro Advanced. You can, however, use a compatible version of FileMaker Server to serve runtime solution files.
- Apple events are supported but OLE automation is not supported in the runtime application on Windows machines.
- Runtime applications cannot be shared over a network.
- Runtime applications do not include the ability to Save/Send Records as Adobe PDF files.
- FileMaker Pro Advanced features are not available in the runtime application. A runtime database can, however, be opened in either FileMaker Pro or FileMaker Pro Advanced. The full functionality of these applications will be enabled, except if full access privileges have been removed.
- Runtime applications don’t support external SQL data sources (ESS), ODBC import, or the Execute SQL script step.
- Charts are not supported in runtime solutions.
Application and document preferences

In the runtime application, some options are not available on the General tab of the Preferences dialog box.

The Layout tab is changed to the Color tab in the Preferences dialog box for the runtime application.

The File Options dialog box in the runtime application displays only the Spelling tab.
## Menu command comparison

The following tables show the menu commands that are available in FileMaker Pro (Pro) and in the runtime application (RT).

<table>
<thead>
<tr>
<th>File Menu command</th>
<th>Windows Pro</th>
<th>Windows RT</th>
<th>Mac OS X Pro</th>
<th>Mac OS X RT</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Database</td>
<td>■</td>
<td>■</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>New From</td>
<td>■</td>
<td>■</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Open</td>
<td>■</td>
<td>■</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Open Remote</td>
<td>■</td>
<td>■</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Open Recent</td>
<td>■</td>
<td>■</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Open Favorite</td>
<td>■</td>
<td>■</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Close</td>
<td>■</td>
<td>■</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Manage</td>
<td>■</td>
<td>■</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Sharing</td>
<td>■</td>
<td>■</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>File Options</td>
<td>■</td>
<td>■</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Change Password</td>
<td>■</td>
<td>■</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Print Setup</td>
<td>■</td>
<td>■</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Page Setup</td>
<td>■</td>
<td>■</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Print</td>
<td>■</td>
<td>■</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Import Records</td>
<td>■</td>
<td>■</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Export Records</td>
<td>■</td>
<td>■</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Save/Send Records As</td>
<td>■ 1</td>
<td>■ 1</td>
<td>■ 1</td>
<td>■ 1</td>
</tr>
<tr>
<td>Send</td>
<td>■ 2</td>
<td>■ 2</td>
<td>■ 2</td>
<td>■ 2</td>
</tr>
<tr>
<td>Save a Copy As</td>
<td>■</td>
<td>■</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Recover</td>
<td>■ 3</td>
<td>■ 4</td>
<td>■</td>
<td>■</td>
</tr>
<tr>
<td>Exit</td>
<td>■</td>
<td>■</td>
<td>■</td>
<td>■</td>
</tr>
</tbody>
</table>

1. You can’t Save/Send Records as PDFs or Snapshot Links
2. You can’t Send a Link to Database
3. Press Ctrl+Shift
4. Press Option+Shift

**Note** You can add menu items that mimic **Open**, **Close**, and **Recover** menu commands to a runtime application using custom menus based on a script or script step. For more information, see “Creating custom menus” on page 22.
### Edit Menu command

<table>
<thead>
<tr>
<th>Command</th>
<th>Windows Pro</th>
<th>Windows RT</th>
<th>Mac OS X Pro</th>
<th>Mac OS X RT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo/Can’t Undo</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Redo/Can’t Redo</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Cut</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Copy</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Paste</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Paste Special</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Clear</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Duplicate</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Select All</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Find/Replace</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Spelling</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Object</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Export Field Contents</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Preferences</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
</tbody>
</table>

### View Menu command

<table>
<thead>
<tr>
<th>Command</th>
<th>Windows Pro</th>
<th>Windows RT</th>
<th>Mac OS X Pro</th>
<th>Mac OS X RT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse Mode</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Find Mode</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Layout Mode</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Preview Mode</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Go to Layout</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>View as Form</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>View as List</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>View as Table</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Status Toolbar</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Customize Status Toolbar</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Formatting Bar</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Text Ruler</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Zoom In</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
</tbody>
</table>
### Insert Menu command

<table>
<thead>
<tr>
<th>Command</th>
<th>Windows</th>
<th></th>
<th></th>
<th>Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td>Picture</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>QuickTime</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sound</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>File</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Object</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Current Date</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Current Time</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Current User Name</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>From Index</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>From Last Visited Record</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Format Menu command

<table>
<thead>
<tr>
<th>Command</th>
<th>Windows</th>
<th></th>
<th></th>
<th>Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Size</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Style</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Align Text</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Line Spacing</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Text Color</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Records Menu command

<table>
<thead>
<tr>
<th>Command</th>
<th>Windows</th>
<th></th>
<th></th>
<th>Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Record</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Duplicate Record</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete Record</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete Found Records/Delete All Records</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Go to Record</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Refresh Window</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show All Records</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show Omitted Only</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Omit Record</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Omit Multiple</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modify Last Find</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Records Menu command

<table>
<thead>
<tr>
<th>Command</th>
<th>Windows Pro</th>
<th>Windows RT</th>
<th>Mac OS X Pro</th>
<th>Mac OS X RT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saved Finds</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sort Records</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unsort</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Replace Field Contents</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Relookup Field Contents</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Revert Record</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Requests Menu command

#### (Find mode)

<table>
<thead>
<tr>
<th>Command</th>
<th>Windows Pro</th>
<th>Windows RT</th>
<th>Mac OS X Pro</th>
<th>Mac OS X RT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add New Request</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Duplicate Request</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete Request</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Go to Request</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show All Records</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Perform Find</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Constrain Found Set</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Extend Found Set</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Revert Request</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Scripts Menu command

<table>
<thead>
<tr>
<th>Command</th>
<th>Windows Pro</th>
<th>Windows RT</th>
<th>Mac OS X Pro</th>
<th>Mac OS X RT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manage Scripts</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save Script</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save All Scripts</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Revert Script</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<Script names>

**Note** The Save Script, Save All Scripts, and Revert Script menu commands only appear when the Manage Scripts or Edit Script dialog box is active.
Appendix A  |  Feature comparison of the runtime application with FileMaker Pro  

### Window Menu command

<table>
<thead>
<tr>
<th>Command</th>
<th>Windows Pro</th>
<th>Windows RT</th>
<th>Mac OS X Pro</th>
<th>Mac OS X RT</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Window</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show Window</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hide Window</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Minimize Window</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tile Horizontally</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tile Vertically</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cascade Windows</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Arrange Icons</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bring All To Front</td>
<td></td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;Names of open files&gt;</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>

### Help Menu command

<table>
<thead>
<tr>
<th>Command</th>
<th>Windows Pro</th>
<th>Windows RT</th>
<th>Mac OS X Pro</th>
<th>Mac OS X RT</th>
</tr>
</thead>
<tbody>
<tr>
<td>FileMaker Pro Help</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Keyboard Shortcuts</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Quick Start Screen</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resource Center</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Product Documentation</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Consultants and Solutions</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Provide FileMaker Feedback</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Check for Updates</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Register FileMaker Pro</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FileMaker Forum</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service and Support</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
<tr>
<td>About FileMaker Pro (or About FileMaker Pro Advanced)</td>
<td>✔️</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>About FileMaker Pro Runtime</td>
<td></td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>(Displays if no custom About script is specified)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>About &lt;runtime solution&gt;</td>
<td></td>
<td></td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>(Displays if custom About script is specified)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;Runtime solution Help script name&gt;</td>
<td></td>
<td></td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>(Displays if custom Help script is specified)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1. See Application Menu command table
Because some features have been removed from the runtime application, the following script steps are ignored by the runtime application:

- Open Manage Database
- Open Manage Value List
- Open Manage Data Sources
- Open Manage Scripts
- Open Manage Layouts
- Open Sharing
- Open Help
- Set Multi-User
- New File
- Open File Options (partially available; Spell checking tab will open)
- Open Remote
- Execute SQL
- Save Records As PDF
- Save Records As Snapshot Link

**Note**  Open File returns an error if the specified file has not been bound to the runtime application. A runtime solution can only perform an external script if the external file is bound to the runtime solution.
Stored registry settings or preferences

Windows registry settings
FileMaker Pro stores its registry settings at
HKEY_CURRENT_USER\Software\FileMaker\FileMaker Pro\.0
FileMaker Pro Advanced stores its registry settings at
HKEY_CURRENT_USER\Software\FileMaker\FileMaker Pro\.0A
The runtime application stores its registry settings at
HKEY_CURRENT_USER\Software\FileMaker\<solution name>\.0

Note  The filename extension for the runtime database files is registered at HKEY_CLASSES_ROOT.

Mac OS X preferences
FileMaker Pro stores its preferences settings in
com.filemaker.client.pro.plist
FileMaker Pro Advanced stores its preferences settings in
com.filemaker.client.advanced.plist
The runtime application stores its preferences in
com.filemaker.client.runtime.<Solution name>.plist
Index

A
About layout 6
  described 6
  required contents of 7
access privileges 7, 19
accounts and privileges 7, 19
  for Kiosk mode 17
  removing Admin access 10
Admin access
  removing from files 10
  removing from Kiosk solutions 18
Apple events in runtime applications 39
attributes in layout themes 25
authenticating scripts 30
auxiliary files
  problems with double-clicking icons 13
  updating 17

B
backups 16
binding key
  about 12
  updating runtime database solutions 16
  binding runtime solutions 12

C
C/C++ 35
calculations
  advanced 31
  using external functions 35
colors, layout themes 26
commands, menu
  available in runtime applications 41
compression utilities for runtime databases 15
configuring plug-ins 37
converting files from previous versions 11
copying field or table schemas 19
cross-platform solutions 12
custom functions, creating 20
custom menus
  about 20
  creating 22
  example 21
  menu items 23
  menu sets 24

database schemas
  copying or importing 19
  in Database Design Report 33
database statistics 33
database structure, recreating 33
DDR. See Database Design Reports
database statistics, recreating 33
debugging scripts 29
delay, splash screen 12
Developer Utilities
  about 9
  creating runtime solutions 11
disabling script steps 30
distributing runtime database solutions
  about 13
  distributing updates 16
terms and conditions 6
documenting
  Database Design Reports 33
  runtime solutions 15
Dynamic Link Libraries (DLLs) 13

E
Edit menu commands available in runtime applications 42
electronic documentation 6
elements in layout themes 27
error codes, viewing from Script Debugger 29
error log 10
Execute SQL script step 46
expressions, monitoring 31
Extensible Markup Language (XML). See XML
Extensions folder, location of plug-ins 36
extensions, filename. See filename extensions
external function plug-ins
  described 35
  enabling 36
  in runtime applications 39
external functions 35
F

fields
  copying schema 19
  monitoring 31
File menu commands available in runtime applications 41
File Options available in runtime application 40
file references. See data sources
FileMaker Developer. See FileMaker Pro Advanced
FileMaker Pro Advanced
documentation 5
  license agreement 6
  upgrading from earlier versions 11
FileMaker Pro, menus available 41
FileMaker Server 15, 35, 39
filename extensions
  for database files 10
  for runtime solutions 12
  layout themes 26
  plug-ins 36
files
  compressing runtime 15
  converting 11
  removing Admin access 10
  renaming 9
  updating 10
fmplugin filename extension 36
fmx filename extension 36
folder structure, solution 13
fonts
  layout themes 25
  not on user’s system 14
Format menu commands available in runtime applications 43
formulas
  for custom functions 20
  monitoring 31
fth filename extension 26
functions
  custom 20
  external 35
  monitoring in formulas 32

H

Help
  menu commands available in runtime applications 45
Help layout 15
HTML format for Database Design Reports 33

I

icons for runtime solutions 13
Insert menu commands available in runtime applications 43
installation instructions 6
installers for runtime databases 14
InstallShield 14
Internet
databases on 6
runtime applications on 39

J

JDBC, FileMaker as data source 6

K

keyboard shortcuts in custom menu items 24
Kiosk solutions, creating 17

L

Layout mode commands, unavailable in runtime applications 39
layout themes, creating 25
legal requirements 6
license agreement 6
Logfile.txt 10
logo, adding to runtime solution 12

M

Mac OS X
  runtime application package 14
  stored preferences 47
MacInstallerBuilder 14
Manage Scripts 30
Manage submenu, unavailable in runtime applications 39
menu commands, available in runtime applications 41
menu separators 23
menu sets, creating 24
messages, error log 10
Microsoft Windows, stored registry settings 47
MindVision Installer VISE 14
multiple tables per database file 11

N

naming runtime database solutions 12
networks, sharing solutions on 15
new features 6
New File script step 46
New Layout/Report assistant 25, 27
O
ODBC, FileMaker as data source 6
OLE automation in runtime applications 39
Open File Options script step 46
Open File script step 46
Open Help script step 46
Open Manage Data Sources script step 46
Open Manage Database script step 46
Open Manage Layouts script step 46
Open Manage Scripts script step 46
Open Manage Value List script step 46
Open Remote script step 46
Open Sharing script step 46
opening files in runtime applications 39

P
passwords, required warning in About layout 7
patterns, layout themes 26
PDF documentation 6
plug-ins
  configuring 37
  in runtime applications 39
  installing 36
  preparing 35
preferences available in runtime application 40
primary file
  connecting auxiliary files 11
  specifying 9
  updating 16
Project Folder 9, 13

R
Records menu commands available in runtime applications 43
recovering damaged runtime files 15
registry, stored settings 47
renaming files 9
reports, database 33
Requests menu commands available in runtime applications 44
runtime applications
  available menu commands 41
  compared to FileMaker Pro 39
  enabling plug-ins in 39
  icon 13
  ignored script steps 46
  stored Mac OS X preferences 47
  stored Windows registry settings 47
runtime database solutions
  About layout requirements 7, 15
  binding files 12
  converting 11
  creating 9, 11
  documenting 13
  preparing files 11
  recovering damaged files 15
  starting 13
  updating 16
  upgrading 11

S
Save Records as PDF script step 46
Save Records as Snapshot Link script step 46
schemas, database
  copying or importing 19
  documenting 33
Script Debugger
  described 29
  with script triggers 30
script triggers, debugging 30
scripts
  authenticating 30
  debugging 29
  disabling script steps 30
  steps ignored by runtime applications 46
  unlocking 30
Scripts menu
  commands available in runtime applications 44
  separators, menu item 23
Set Multi-User script step 46
settings file 10
shortcuts, keyboard. See keyboard shortcuts
solution file
  icon 13
  problems with double-clicking icon 13
splash screen in runtime solutions
  closing 12
  startup 11
starting runtime solutions 13
statistics, database 33
structure, database 33
tables, database
  copying or importing schema 19
  excluding from Database Design Report 33
  multiple per file 11
  testing
    database solutions 16
    scripts 29
text editors 25
themes. See layout themes
touch screen 17
troubleshooting
  calculations 31
  fields 31
  Script Debugger 29
  using Database Design Reports 33
  variables 31
tutorial, FileMaker Pro 6
unlocking scripts 30
updates
  plug-ins 35
  to runtime solutions 16
upgrading runtime databases 11
user interaction with database solution 11
variables, monitoring 31
View menu commands available in runtime applications 42
web browser users 6
web viewer 15
Window menu commands available in runtime applications 45
Windows runtime application package 14
XML
  documents for layout themes 25
  editors 25
  format for Database Design Reports 33
  output grammar for DDR 6
  XML 1.0 specification 27
  XML-document processing instruction 27